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Foreword

Information Communication Technology (ICT) is one of the rapidly changing
area in domain of learning. The main purpose of introducing ICT in schools is to help
the students to make use of different ICT tools in enhancing their learning. The ICT
education helps the students to face the challenges of 21st century and attain the
millennium developmental goals in education. ICT also helps in reducing  the digital
divide among the rural and urban students.

As per the UNESCO “technology can be a powerful education multiplier, but
we must know how to use it. It is not enough to install technology into classrooms- it
must be integrated into learning. Nothing can be substitute for a good teacher. It is not
technology itself that empowers people- empowerment comes from skills and
knowledge”.

The teachers have become more critical than ever- the challenge is how to
enable teachers not only to overcome the technology barriers but also to empower
them to integrate appropriate technology into the teaching and learning process.

This handbook contains the required content in using the different tools and use
them in other subjects i.e. Mathematics, Science, Social Science and languages.

 The SCERT, Telangana, Hyderabad appreciates the efforts of the content experts
and other team members in developing this  ICT handbook. We also acknowledge the
C-DAC, Hyderabad for sharing their content related to software security in the
preparation of this handbook.

We hope, the teacher may find this handbook useful and transact it in the classroom
to enhance the learning levels of the students and also infuse confidence among them
as they were not left behind  in using technology on par with other students who are
studying in corporate schools.

 Director
S C E R T,

Telangana, Hyderabad.
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Instructions to Teachers

The main purpose of introducing ICT in school syllabus is to help the children  understand

how to make use of ICT tools in enhancing their learning.

 This material is meant for teacher only. Hence, the teacher should read, understand

and add their experience while transacting the same to students.

 Prepare a year plan in advance keeping in view of the number of periods available

under computer education.

 Read all the topics given in the handbook and prepare thoroughly before start teaching.

 Refer to relevant material and consult the experts in case of any doubts.

 Before going to practice, the theory/ content should be explained to students then

only demo and practice sessions should be taken up.

 All abbreviations must be thoroughly practised  by the teacher before teaching.

 Update your knowledge in software and hardware in addition to the latest ICT tools.

Use internet to update the knowledge in the given topics.

 Ensure all children get equal opportunities in practices.

 There will be two periods in a week for ICT (Computer Education) subject,

accordingly, teacher has to plan for transaction.

 Few projects are given at the end of the handbook. All students should do these

projects. In addition to these, you may consult your colleagues and identify some

more projects and assign to your students.

Assessment :

Children’s performance should be assessed at the end of each summative based on

the indicators given below:

 Students are able to operate and use the ICT tools;

 Students are able to learn subject-wise content by using ICT tools.
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There is no written test. The children performance should be assessed  through

observation based on their participation and their ability in using the ICT tools in their

learning.

Assessment Indicators
In addition to grading the qualitative Indicators are to be written in the students’

progress report under Computer Education. The following are the indicators:

A1 Students can use all the tools of the ICT and can use them effectively in their learning.

A2 Students can use all the tools of the ICT and able to use them in their learning.

B1 Students are able to use different tools of ICT and able to use most of them in their
learning.

B2 Students are able to use the different tools of ICT and use some of them in their learning.

C1 Students are able to use the ICT tools and able to use a few of them in their learning.

C2 Students are able to use some of the ICT tools and try to use them in their learning.

D1 Students are able to identify the ICT tools and try to use a few of them in their learning.

D2 Students are able to identify some of the ICT tools but they are unable to use them in
their learning.

Note: The computer education is linked with Work Education and made a single

paper under other curricular subject areas. Hence, out of 50 marks, each 25 marks are to be

allotted to Work Education and Computer Education.

*****
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Information and Communication Technology (ICT)

Introduction

The field of Information and Communication Technology (ICT) is evolving at
such a pace, where concepts, technology and terminology are continuously changing.
ICT helps to  bridge the digital divide amongst students of various socio economic and
other geographical barriers. Information and Communication Technology (ICT) is
universally acknowledged as an important catalyst for social transformation and national
progress.

Information and communication technology which is a by-product of science
and technology explosion has revolutionized the world of learning. It is very essential
to integrate IT with education in order to have the advantage of ICT education.

Around the world, policymakers and educators have high hopes for ICT in the
classroom as a springboard to students “21st century  skills”—that  combines  the
competencies of problem solving, critical thinking and managing their own learning
that is needed for success in the global workplace. 

Information and Communication Technology (ICT) has dominated every walks
of life affecting right from bus &  railway reservations, hotel industry, online money
transfers , bill payments, in class room  teaching and learning process, distance
education, e-learning and  film making  etc..

The learning activities through ICT make a difference. Students are much more likely
to learn to solve real-world problems and collaborate productively with their peers, if
their learning activities are carefully designed to offer opportunities.

The aim of 21st Century education is being redefined. It is not only for
employment generation but also to create a better world through understanding and
development of human qualities.

In this context, the Government of India has announced 2010 – 2020 as the
decade of Innovation. For which, reasoning and critical thinking skills are essential.
And these skills are to be inculcated at the school level for which ICT tools and
techniques should be integrated into class room instructions right from the primary
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education level, so that the children develop the required skills.  In this matter the web
is an open source and the child should know how to grab it.

According to UNESCO, education is important to achieve the Millennium
Development goals; the following are reasons for which the ICT in education is a key
aspect. i.e., ‘More people would grow and develop; More people would learn and
know; More people would be equal and just; More children would survive and live;
More mothers would be healthier; More people would be able to combat illness;
More people would think of the future; More people would work together.”

The purpose of this material is to create an awareness and practice among the
student and teacher communities with a “diverse set of technological tools, resources
used to communicate, create, disseminate, store, and manage information.” These
technologies include computers, internet, broadcasting technologies (radio and
television) and telephony.

The relevant and contemporary content, lucid language, attractive illustrations
and constructive exercises make the learning of computers more meaningful and
enriching.

The journey of the student starts right from the ICT tools available in and around
such as Radio, Tape recorder, TV, Mobile and Computer. The students of primary level
learn to draw by using MS & Tux Paint, learn to type small words, sentences, paragraphs,
making documents by using typing tutor and MS Word. Moving away a little from these
applications, the students can learn MS Excel for mathematical calculations & graphs
and MS Power Point for making subject wise presentations. Further, the students learn
the concepts of Data Base Management System (DBMS), Internet, Networking and
computer languages, maintaining the computers and its peripherals. The students are
also introduced to learn about the Antivirus, Computer security and privacy and open
source software technologies.

This material is useful in acquiring the concepts  in a better way which make the
student journey in learning more fruitful and engrossing. It has been developed in tune
with the guidelines given by NCF-2005 and with various activity based methods. This
will lay down a path to create interest to take up high level computer education courses
in future and career.



ICT Teacher Hand Book 3

The government had initiated Computer Education and Computer Aided Learning
in selected Primary, Upper Primary and High Schools. A huge number of teachers in
the State already have been trained to use computers in their regular class room
transactions and a lot of computer aided learning material also has been developed and
supplied to schools.

As part of Education Technology Policy, the Education Department of Andhra
Pradesh has been developing  a large quantity of material in the form of  Audio
(Radio Programs under Vindam Nerchukundam), Audio and Video based programs (SIET
and SAP Net) and Computer based programs(CDs) in collaboration with NGOs.

The Objectives of the ICT in School Education:

 To inculcate the ICT skills among the students of government schools.

 To bridge the digital divide between rural and urban students.

 To create computer awareness and literacy among students and teachers.

 To provide ICT  environment in schools to make teaching-learning process
effective and interesting

 To train the teachers on computer syllabi, emerging information and
communication technologies.

 To develop confidence in students to use computers in future.

 Student-centered pedagogies that promote personalized and  powerful learning
for students;

  Extending learning beyond the classroom in ways most relevant to  knowledge-
building and problem-solving in today’s world; and

 ICT integration into pedagogy in ways that support learning goals.  It is important
to note that ICT use is not a goal in itself, but a tool to broaden and deepen
learning opportunities.
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Teaching Learning Process

The ICT material has been developed from class 1 to class 10. The teacher can
act as a facilitator to help the students in their learning process. In every Unit the
teacher explains the concepts and students do the activities/projects with ICT tools and
finally able to integrate with their subjects.

Academic Standards and Assessment

Academic Standards

 The students are shall operate and use the ICT tools;

 Students are shall learn subject wise contents through the ICT tools.

Assessment Process

At the end of the each chapter exercises and projects have been given. On the
basis of the students performance appropriate grade may be awarded in summative
assessment.

*****
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Learning Objectives

In this chapter you will be able to understand about ;

G  The Information and Communication Technology.

Information and Communication Technology (ICT)

Information and communication technology or (ICT) is often used as an extended
synonym for information technology (IT), but is a more specific term that stresses the role
of unified communications and the integration of telecommunications (telephone lines and
wireless signals), computers as well as necessary enterprise software, middleware, storage,
and audio-visual systems, which enable users to access, store, transmit, and manipulate
information.

The phrase ICT had been used by academic researchers since the 1980s, but it became
popular after it was used in a report to the UK government by Dennis Stevenson in 1997
and in the revised National Curriculum for England, Wales and Northern Ireland in 2000.

The term ICT is now also used to refer to the convergence of audio-visual
and telephone networks with computer networks through a single cabling or link system.
There are large economic incentives (huge cost savings due to elimination of the telephone
network) to merge the audio-visual, building management and telephone network with the
computer network system using a single unified system of cabling, signal distribution and
management.

The term Info communications is used in some cases as a shorter form of information
and communication(s) technology. In fact, Info communications is the expansion of
telecommunications with  information processing  and content handling functions  on  a
common digital technology base, for a comparison of these and other terms.

What is ICTChapter - 1
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Technological capacity of ICT 

The world’s technological capacity to store information grew from 2.6 (optimally
compressed) Exabyte in 1986 to 15.8 in 1993, over 54.5 in 2000, and to 295 (optimally
compressed) Exabyte in 2007. This  is  the  informational equivalent  to 404 billion CD-
ROM in 2007. Piling them up would create a stack from the earth to the moon and a quarter
of this distance beyond (with 1.2 mm thickness per CD). The world’s technological capacity
to receive information through one-way broadcast networks was 432 Exabyte of (optimally
compressed) information in 1986, 715 (optimally compressed) Exabyte in 1993, 1.2
(optimally compressed) zettabytes in 2000, and 1.9 zettabytes in 2007. The world’s effective
capacity to exchange information through two-way telecommunication networks was
281 petabytes of (optimally compressed) information in 1986, 471 petabytes in 1993, 2.2
(optimally compressed) Exabyte in 2000, and 65 (optimally compressed) Exabyte in
2007. The world’s technological capacity to compute information with humanly guided
general-purpose computers grew from 3.0 × 10^8 MIPS in 1986, to 6.4 x 10^12 MIPS in
2007

Mobile Hub – the next version of ICT

The Mobile Web refers to access to the world wide web, i.e. the use of browser-
based Internet services, from a handheld mobile device, such as a smartphone, a feature
phone or a tablet computer, connected to a mobile network or other wireless network.

Traditionally, access to the Web has been via fixed-line services on large-screen
laptops and desktop computers. However, the Web is becoming more accessible by portable
and wireless devices. An early 2010 ITU (International Telecommunication Union) report
said that with the current growth rates, web access by people on the go — via laptops and
smart mobile devices – is likely to exceed web access from desktop computers within the
next five years. The shift to mobile Web access has been accelerating with the rise since
2007 of larger multi touch smart phones, and of multi touch tablet computers since 2010.
Both platforms provide better Internet access, screens, and mobile browsers- or application-
based user Web experiences than previous generations of mobile devices have done. Web
designers may work separately on such pages, or pages may be automatically converted as
in Mobile Wikipedia.
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The distinction between mobile Web applications and native applications is
anticipated to become increasingly blurred, as mobile browsers gain direct access to the
hardware of mobile devices (including accelerometers and GPS chips), and the speed and
abilities of browser-based applications improve. Persistent storage and access to
sophisticated user  interface graphics  functions  may  further  reduce  the  need  for
the development of platform-specific native applications.

Mobile Web access today still suffers from  inter-operability and usability problems.
Interoperability issues stem from the platform fragmentation of mobile devices, mobile
operating systems, and browsers. Usability problems are centered around the small physical
size of the mobile phone form factors (limits on display resolution and user input/operating).
Despite these shortcomings, many mobile developers choose to create apps using Mobile
Web. A June 2011 research on mobile development found Mobile Web the third most used
platform, trailing Android and IOS.

Summary

In this chapter you have learnt about the ICT and its next version.

1.  Display the available ICT devices to the students at the school.

G   Android

G   Chips

G   Wikipedia

*****

Teacher Activity

Key Words
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Learning Objectives

In this chapter you will be able to understand about ;

G   The various models of Microprocessors.

Introduction

By understanding about the Microprocessors you will be able to judge the best
computer you would like to purchase or work with.

Microprocessor

A microprocessor incorporates  the  functions of  a computer’s central  processing
unit (CPU) on a single integrated circuit (IC), or at most a few integrated circuits. It is a
multipurpose, programmable device that accepts digital data as input, processes it according
to instructions stored in its memory, and provides results as output. It is an example
of sequential digital logic, as it has internal memory. Microprocessors operate on numbers
and symbols represented in the binary numeral system.

The advent of low-cost computers on integrated
circuits has transformed modern society. General-purpose
microprocessors in personal computers are used for
computation, text editing, multimedia display, and
communication over the Internet. Many more
microprocessors are part of embedded systems, providing
digital control over myriad objects from appliances to
automobiles to cellular phones and industrial process
control.

Origins

During the 1960s, computer processors were constructed out of small and medium-
scale IC’s—each containing from tens to a few hundred transistors. These were placed and
soldered onto printed circuit boards, and often multiple boards were interconnected in a

Microprocessor

Types  of  MicroprocessorsChapter - 2
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chassis. The large number of discreet logic gates used more electrical power—and therefore
produced more heat—than a more integrated design with fewer ICs. The distance that signals
had to travel between ICs on the boards limited a computer’s operating speed.

In the NASA Apollo space missions to the moon in the 1960s and 1970s, all onboard
computations for primary guidance, navigation and control were provided by a small custom
processor called “The Apollo Guidance Computer”. It used wire wrap circuit boards whose
only logic elements were three-input NOR gates.

The integration of a whole CPU into a single chip or on a few chips greatly reduced
the cost of processing power. The integrated circuit processor was produced in large numbers
by highly automated processes, so unit cost was low. Single-chip processors increase
reliability as there are many fewer electrical connections to fail. As microprocessor designs
get faster, the cost of manufacturing a chip (with smaller components built on a
semiconductor chip of the same size) generally stays the same.

Microprocessors integrated into one or a few large-scale ICs the architectures that
had previously been implemented using many medium- and small-scale integrated circuits.
Continued increases in microprocessor capacity have rendered other forms of computers
almost completely obsolete (see history of computing hardware), with one or more
microprocessors used in everything from the smallest embedded systems and handheld
devices to the largest mainframes and supercomputers.

The first microprocessors emerged in the early 1970s and were used for
electronic calculators,  using binary-coded  decimal (BCD)  arithmetic  on  4-bit words.
Other embedded uses of 4-bit and 8-bit microprocessors, such as terminals, printers, various
kinds of automation etc., followed soon after. Affordable 8-bit microprocessors with 16-
bit addressing also led to the first general-purpose microcomputers from the mid-1970s
on.

Since the early 1970s, the increase in capacity of microprocessors has
followed Moore’s law; this originally suggested that the number of components that can be
fitted onto a chip doubles every year. With present technology, it is actually every two
years,  and as such Moore later changed the period to two years.
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Embedded applications

Thousands of items that were traditionally not computer-related include
microprocessors. These include large and small household appliances, cars (and their
accessory equipment units), car keys, tools and test instruments, toys, light switches/
dimmers and electrical circuit breakers, smoke alarms, battery packs, and hi-fi audio/visual
components (from DVD players to phonograph turntables). Such products as cellular
telephones, DVD video system  and HDTV broadcast  systems  fundamentally  require
consumer devices with powerful, low-cost, microprocessors. Increasingly stringent pollution
control standards effectively require automobile manufacturers to use microprocessor
engine management systems, to allow optimal control of emissions over widely varying
operating conditions of an automobile. Non-programmable controls would require complex,
bulky, or costly implementation to achieve the results that are possible with a
microprocessor.

A microprocessor control program (embedded software) can be easily tailored to
different needs of a product line, allowing upgrades in performance with minimal redesign
of the product. Different features can be implemented in different models of a product line
at negligible production cost.

Microprocessor control of a system can provide control strategies that would be
impractical to implement using electromechanical controls or purpose-built electronic
controls. For example, an engine control system in an automobile can adjust ignition timing
based on engine speed, load on the engine, ambient temperature, and any observed tendency
for knocking—allowing an automobile to operate on a range of fuel grades.

Types of Computers

Personal Computers (PC) :
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Mainframe Computers with large Hard Drives, lots of
Memory (RAM), multiple CPU’s running together, does
lots of computing depending upon the speed of processors
and memory used.

Super Computer : A computer with lots of processors,
ALUs (Arithmetic logic unit), Memory (RAM), etc. Usually
in scientific research work. Capability of 14,000 micro
computers.

Laptop: Compact, portable version of a PC. Usually in a
notebook shape.

Micro Computer: A very small
computer, usually used in cameras.
A microcomputer (sometimes
shortened to micro) is a computer with a microprocessor as
its central processing unit.

Another general characteristic of these computers is
that they occupy physically small amounts of space when
compared to mainframe and minicomputers.

PDA: Personal Digital Assistant or Palmtop

A Personal Digital Assistant (PDA) is a
handheld computer, but has become much more versatile
over the years. PDAs are also known as small computers
or palmtop computers. PDAs have many uses:
calculation, use as a clock and calendar, accessing the
Internet, sending and receiving E-mails, video recording,
typewriting and word processing, used as an address
book, making and writing on spreadsheets, scanning bar
codes, use as a radio or stereo, playing computer games,
recording survey responses, and Global Positioning
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System (GPS). Newer PDAs also have both color screens and audio capabilities, enabling
them to be used as mobile phones (smart phones), web browsers, or portable media players.
Many PDAs can access the Internet, intranets or extranets via Wi-Fi, or Wireless Wide-
Area Networks (WWANs). Many PDAs employ touch screen technology.

Analog, Digital & Hybrid Computers

Analog: They calculate physical
quantities, eg. Ammeter, voltage meter,
etc. They are old, out dated computers.
An analog computer is a device that
performs computations using
continuous physical variables which are
analogs of the actual items being
computed. Analog computers might, for
example, use the continuous rotation of

gears or the angular movements of mechanical or electromechanical parts to perform
computations.

Digital: That uses binary digits
for processing. eg. Personal  Computers.
A computer that stores data in terms of
digits (numbers) and proceeds in discrete
steps from one state to the next. The states
of a digital computer typically involve
binary digits which may take the form of
the presence or absence of magnetic
markers in a storage medium on-off
switches or relays. In digital computers, even letters, words and whole texts are represented
digitally. Unlike analog computers, digital computers can only approximate a continuum by
assigning large numbers of digit to a state description and by proceeding in arbitrarily small
steps.
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Hybrid: They comprise the best of
capabilities of digital and analog computers.
Hybrid computers are computers that comprise
features of analog computers and digital
computers. The digital component normally
serves as the controller and provides logical
operations, while the analog component normally
serves as a solver of differential equations.

Summary

In this chapter you have learnt the history of Microprocessor.

Collect the colour pictures of various computers and show them to students.

1. Collection of various types of computer pictures from news papers & magazines.

2. Category wise album preparation.

G  Mainframe

G   Super Computer

G   PDA (Personal Digital Assistant)

G   Analog, Hybrid

*****

Teacher Activity

Student Activity

Key Words
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Learning Objectives

In this chapter you will be able to understand about ;

G What Modem is?

G History of Modem,

G Types of Modems.

Introduction

By understanding about the modem you will gain knowledge on how computers are
connected with other computer by Internet.

A modem (modulator-demodulator) is a device that modulates an analog carrier
signal to encode digital information, and also demodulates such a carrier signal to decode
the transmitted information. The goal is to produce a signal that can be transmitted easily
and decoded to reproduce the original digital data. Modems can be used over any means of
transmitting analog signals, from light emitting diodes to radio. The most familiar example
is a voice band modem that turns the digital data of a personal computer into modulated
electrical signals in the voice frequency range of a telephone channel. These signals can
be transmitted over telephone lines and demodulated by another modem at the receiver
side to recover the digital data.

Modems are generally classified by the amount of data they can send in a given unit
of time, usually expressed in bits per second (bit/s, or bps),
or bytes per second (b/s). Modems can alternatively be
classified by their symbol rate, measured in baud.
The baud unit denotes symbols per second, or the number
of times per second the modem sends a new signal. For
example, the ITU V.21 standard used audio frequency shift
keying with two possible frequencies corresponding to two
distinct symbols (or one bit per symbol), to carry 300 bits per second using 300 baud. By
contrast, the original ITU V.22 standard, which was able to transmit and receive four distinct

ModemChapter - 3
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symbols (two bits per symbol), handled 1,200 bit/s by sending 600 symbols per second
(600 baud) using phase shift keying.

History

News wire services in 1920s used multiplex devices that were modems by definition,
but the modem function was incidental to the multiplexing function, so they are not
commonly included in the history of modems.

Modems grew out of the need to connect teleprinters over ordinary phone lines
instead of more expensive leased lines which had previously been used for current loop–
based teleprinters and automated telegraphs. In 1942, IBM adapted this technology to their
unit record equipment and were able to transmit punched cards at 25 bits/second.[citation
needed]

Mass-produced modems in the United States began as part of the SAGE air-defense
system in 1958 (the year the word modem was first used), connecting terminals at various
airbases, radar sites, and command-and-control centers to the SAGE director centers
scattered around the U.S. and Canada. SAGE modems were described by AT&T’s Bell Labs as
conforming to their newly published Bell 101 dataset standard. While they ran on dedicated
telephone lines, the devices at each end were no different from commercial acoustically
coupled Bell 101, 110 baud modems.

In the summer of 1960 the name Data-Phone was introduced to replace the earlier
term digital subset. The 202 Data-Phone was a half-duplex asynchronous service that was
marketed extensively in late 1960. In 1962 the201A and 201B Data-Phones were introduced.
They were synchronous modems using two-bit-per-baud phase-shift keying (PSK). The 201A
operated half-duplex at 2,000 bit/s over normal phone lines, while the 201B provided full
duplex 2,400 bit/s service on four-wire leased lines, the send and receive channels running
on their own set of two wires each.

The famous Bell 103A dataset standard was also introduced by AT&T in 1962. It
provided full-duplex service at 300 bit/s over normal phone lines. Frequency-shift keying was
used with the call originator transmitting at 1,070 or 1,270 Hz and the answering modem
transmitting at 2,025 or 2,225 Hz. The readily available 103A2 gave an important boost to
the use of remote low-speed terminals such as the KSR33, the ASR33, and the IBM 2741.
AT&T reduced modem costs by introducing the originate-only 113D and the answer-only
113B/C modems.
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The Smart modem and the rise of BBSes

The next major advance in modems was the Hayes Smart modem, introduced in 1981.
The Smart modem was an otherwise standard 103A 300-bit/s modem, but it was attached to
a small controller that let the computer send it commands. The command set included
instructions for picking up and hanging up the phone, dialling numbers, and answering calls.
The basic Hayes command set remains the basis for computer control of most modern
modems.

Prior to the Hayes Smart modem, dial-up modems almost universally required a
two-step process to activate a connection. The user had to manually dial the remote number
on a standard phone handset and then plug the handset into an acoustic coupler. Hardware
add-ons, known simply as dialers, were used in special circumstances, and generally operated
by emulating someone dialing a handset.

With the Smart modem, the computer could dial the phone directly by sending the
modem a command, thus eliminating the need for an associated phone instrument for dialing
and the need for an acoustic coupler. The Smart modem instead plugged directly into the
phone line, greatly simplifying setup and operation. Terminal programs that maintained lists
of phone numbers and sent the dialling commands became common.

The Smart modem and its clones also aided the spread of bulletin board
systems (BBSs) because it was the first low-cost modem that could answer calls. Modems
had previously been typically either the call-only, acoustically coupled models used on the
client side, or the much more expensive, answer-only models used on the server side.

Almost all modern modems can inter-operate
with fax machines. Digital faxes, introduced in the 1980s, are
simply a particular image format sent over a high-speed
(commonly 14.4 kbit/s) modem. Software running on the host
computer can convert any image into fax format, which can
then be sent using the modem. Such software was at one time
an add-on, but has since become largely universal.

Soft modem

A Win modem or soft modem is  a  stripped-down modem  that  replaces  tasks
traditionally handled in hardware with software. In this case the modem is a simple interface
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designed to act as a digital-to-analog and an analog-to-
digital converter. Soft modems are cheaper than
traditional modems because they have fewer hardware
components. However, the software generating and
interpreting the modem tones to be sent to the soft
modem uses many system resources. For online
gaming, this can be a real concern. Another problem is
the lack of cross-platform compatibility, meaning that

non-Windows operating systems (such as Linux) often do not have an equivalent driver to
operate the modem.

Broadband

ADSL (Asymmetric Digital Subscriber Line) modems, a more recent development,
are not limited to the telephone’s voice band audio frequencies. Some ADSL
modems use coded orthogonal frequency division modulation (DMT, for Discrete Multi
Tone; also called COFDM, for digital TV in much of the world).

DSL modems utilize a property that standard twisted-pair telephone cable can be
used for short distances to carry much higher frequency signals than what the cable is actually
rated to handle. This is also why DSL modems have a distance limitation. Standard voice and
slower 56 kilobit modem communications are possible over many kilometers of cable, but
the higher frequencies used by DSL are attenuated and DSL’s maximum performance
gradually declines as the cable length increases.

Cable modems use a range of frequencies originally intended to carry RF television
channels, and can coexist on the same single cable alongside standard RF channel signals.
Multiple cable modems attached to a single cable can use the same frequency band, using a
low-level media access protocol to allow them to work together within the same channel.
Typically, uplink and downlink signals are kept separate using frequency division multiple
access.

For a single-cable distribution system, the return signals from customers require
special bidirectional amplifiers or reverse path amplifiers that can send specific customer
frequency bands upstream to the cable plant amongst the other downstream frequency bands.
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New types of broadband modems are beginning to appear, such as double
way[disambiguation needed] satellite and power line modems.

Broadband modems should still be classified as modems, since they use complex
waveforms to carry digital data. They are more advanced devices than traditional dial-
up modems  as  they  are  capable  of modulating/demodulating  hundreds  of  channels
simultaneously.

Many broadband modems include the functions of a router, such as Ethernet and WiFi,
and other features such as DHCP, NAT and firewalls.

When broadband technology was introduced, networking
and routers were unfamiliar to consumers. However, many people
knew what a modem was because Internet access was still
commonly done through dial-up. Due to this familiarity, companies
started selling broadband modems using the familiar term
“modem”, rather than vaguer ones such as “adapter,” “transceiver,”
or “bridge.”

Summary

In this chapter you have learnt about;

G   Modems G   History of Modems G   Types of Modems.

1. Collection & showing of various types of modems (used or new)

2. Demonstration of connection of a modem.

Observe and record the types of modems used in the market.

G   Modem G  Data-Phone G  Smart Modem

G   Soft Modem G  Broadband G  DSL

G   ADSL

*****

Student Activity

Teacher Activity

Key Words
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Learning objectives

In this chapter you will be able to understand about;

G  Multimedia

G  Usage of Multimedia in various sectors.

Introduction

By understanding about Multimedia you can use it for your learning and entertainment
purpose.

Multimedia
         Multimedia is media and content that uses
a combination of different content forms. This
contrasts with media that use only rudimentary
computer displays such as text-only or
traditional forms of printed or hand-produced
material. Multimedia includes a combination
of text, audio, still  images,  animation, video,
or interactivity content forms.

Multimedia is usually recorded and
played, displayed, or accessed by information
content processing  devices,  such  as
computerized and electronic devices, but can
also be part of a live performance. Multimedia devices are electronic media devices used
to store and experience multimedia content. Multimedia is distinguished from mixed
media in fine art; by including audio, for example, it has a broader scope. The term “rich
media” is synonymous for interactive multimedia. Hypermedia can be considered one
particular multimedia application.

Multimedia and its usesChapter - 4
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Categorization of multimedia

Multimedia may be broadly divided into linear and non-linear categories. Linear
active content progresses often without any navigational control for the viewer such as
a cinema presentation. Non-linear uses interactivity to control progress as with a game or
self-paced computer based training. Hypermedia is an example of non-linear content.

Multimedia presentations can be live or recorded. A recorded presentation may allow
interactivity via a navigation system. A live multimedia presentation may allow interactivity
via an interaction with the presenter or performer.

Major characteristics of multimedia

Multimedia presentations may be viewed by person on stage, projected, transmitted,
or played locally with a media player. A broadcast may be a live or recorded multimedia
presentation. Broadcasts and recordings can be either analog or digital electronic media
technology. Digital online multimedia may be downloaded or streamed. Streaming
multimedia may be live or on-demand.

Multimedia games and simulations may be used in a physical environment with special
effects, with multiple users in an online network, or locally with an offline computer, game
system, or simulator.

The various formats of technological
or digital multimedia may be intended to
enhance the users’ experience, for example
to make it easier and faster to convey
information Or in entertainment or art, to
transcend everyday experience.

Enhanced levels of interactivity are
made possible by combining multiple forms
of media content. Online multimedia is increasingly becoming object-oriented and data-
driven, enabling applications with collaborative end-user innovation and personalization on
multiple forms of content over time. Examples of these range from multiple forms of
content on Web sites like photo galleries with both images (pictures) and title (text) user-
updated, to simulations whose co-efficient, events, illustrations, animations or videos are
modifiable, allowing the multimedia “experience” to be altered without reprogramming. In
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addition to seeing and hearing, Haptic technology enables virtual objects to be felt. Emerging
technology involving illusions of taste and smell may also enhance the multimedia
experience.

Terminology 

History of the term

The term multimedia was coined by singer and artist Bob Goldstein (later ‘Bobb
Goldsteinn’) to promote the July 1966 opening of his “LightWorks at L’Oursin” show
at Southampton, Long Island. Goldstein was perhaps aware of a British artist named Dick
Higgins, who had two years previously discussed a new approach to art-making he called
“intermedia.”

On August 10, 1966, Richard
Albarino of Variety borrowed the
terminology, reporting: “Brainchild of
song scribe-comic Bob (‘Washington
Square’) Goldstein, the ‘Light works’ is
the latest multi-media music-cum-
visuals to debut as discothèque
fare.” Two years later, in 1968, the term
“multimedia” was re-appropriated to
describe the work of a political

consultant, David Sawyer, the husband of Iris Sawyer—one of Goldstein’s producers at
L’Oursin.

In the intervening forty years, the word has taken on different meanings. In the late
1970s, the term referred to presentations consisting of multi-projector slide shows timed
to an audio track. However, by the 1990s ‘multimedia’ took on its current meaning.

In the 1993 first edition of McGraw-Hill’s Multimedia: Making It Work, Tay Vaughan
declared “Multimedia is any combination of text, graphic art, sound, animation, and video
that is delivered by computer. When you allow the user – the viewer of the project – to
control what and when these elements are delivered, it is interactive multimedia. When you
provide a structure of linked elements through which the user can navigate, interactive
multimedia becomes hypermedia.”
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The German language society, Gesellschaft für deutsche Sprache, decided to
recognize the word’s significance and ubiquitousness in the 1990s by awarding it the title
of ‘Word of the Year’ in 1995. The institute summed up its rationale by stating “[Multimedia]
has become a central word in the wonderful new media world”

In common usage, multimedia refers to an electronically delivered combination of
media including video, still images, audio, text in such a way that can be accessed interactively.
Much of the content on the web today falls within this definition as understood by millions.
Some computers which were marketed in the 1990s were called “multimedia” computers
because they incorporated a CD-ROM drive, which allowed for the delivery of several
hundred megabytes of video, picture, and audio data. That era saw also a boost in the
production of educational multimedia application CD-ROMs.

Usage / Application

Multimedia finds its application in various areas including, but not limited to, 
advertisements, art,   education,  entertainment, engineering, medicine, 
mathematics, business, scientific  research and spatial  temporal  applications.  Several
examples are as follows:

Creative industries

Creative industries use multimedia for a variety
of purposes ranging from fine arts, to entertainment, to
commercial art, to journalism, to media and software
services provided for any of the industries listed below.
An individual multimedia designer may cover the
spectrum throughout their career. Request for their skills
range from technical, to analytical, to creative.

Commercial uses

Much of the electronic old and new media used by commercial
artists is multimedia. Exciting presentations are used to grab and
keep attention in advertising. Business to business, and interoffice
communications are often developed by creative services firms for
advanced multimedia presentations beyond simple slide shows to
sell ideas or liven-up training. Commercial multimedia developers
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may be hired to design for governmental services and nonprofit services applications as
well.

Entertainment and fine arts

In addition, multimedia is heavily used in the entertainment industry, especially to
develop special effects in movies and animations. Multimedia games are a popular pastime
and are software programs available either as CD-ROMs or online. Some video games also
use multimedia features. Multimedia applications that allow users to actively participate
instead of just sitting by as passive recipients of information are called Interactive
Multimedia. In the Arts there are multimedia artists, whose minds are able to blend techniques
using different media that in some way incorporates interaction with the viewer. One of the
most relevant could be Peter Greenaway who is melding Cinema with Opera and all sorts
of digital media. Another approach entails the creation of multimedia that can be displayed
in a traditional fine arts arena, such as an art gallery. Although multimedia display material
may be volatile, the survivability of the content is as strong as any traditional media. Digital
recording material may be just as durable and infinitely reproducible with perfect copies
every time.

Education

In Education, multimedia  is  used  to  produce computer-based  training courses
(popularly called CBTs) IMLOs (Interactive multimedia learning objects) and reference
books like encyclopedia and almanacs. A CBT lets the user go through a series of
presentations, text about a particular topic, and associated illustrations in various information
formats. Edutainment is  the  combination  of  education with  entertainment,  especially
multimedia entertainment.

Learning theory in the past decade has expanded
dramatically because of the introduction of multimedia.
Several lines of research have evolved (e.g. Cognitive
load, Multimedia  learning,  and  the  list  goes  on).  The
possibilities for learning and instruction are nearly endless.

The idea of media convergence is also becoming a
major factor in education, particularly higher education.
Defined as separate technologies such as voice (and
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telephony features), data (and productivity applications) and video that now share resources
and interact with each other, synergistically creating new efficiencies, media convergence
is rapidly changing the curriculum in universities all over the world. Likewise, it is changing
the availability, or lack thereof, of jobs requiring this savvy technological skill.

The English education in middle school in China is well invested and assisted with
various equipments. In contrast, the original objective has not been achieved at the desired
effect. The government, schools, families, and students spend a lot of time working on
improving scores, but hardly gain practical skills. English education today has gone into the
vicious circle. Educators need to consider how to perfect the education system to improve
students’ practical ability of English. Therefore an efficient way should be used to make the
class vivid. Multimedia teaching will bring students into a class where they can interact with
the teacher and the subject. Multimedia teaching is more intuitive than old ways; teachers
can simulate situations in real life. In many circumstances teachers don’t have to be there,
students will learn by themselves in the class. More importantly, teachers will have more
approaches to stimulating students’ passion of learning.

Summary

In this chapter you have learnt about the Multimedia and its utility in Education and
various platforms.

1. Collection and maintenance of Multimedia CD’s library.

2. Demonstration of Multimedia CD’s duly explains the components of video, text,
pictures, audio etc.,

1. Name any five Multimedia CD’s available in School.

2. Take a Multimedia CD and categorize the components i.e., video, audio, pictures,
text etc.,

G  Multimedia G   Interactivity G   Combination

G   CBTs G   IMLOs G   Encyclopedia

*****

Teacher Activity

Student Activity

Key Words
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Learning Objectives

In this chapter you will be able to understand about ;

G Internet ethics.

G Internet ethics for Children

Internet ethics for children means it is one easy way to think about behaviour of
using internet. Children should be aware that they should, be honest, respect the rights and
property of others on Internet.

Accept that the Internet is not a free zone

The World Wide Web is a place where the values in the broadest
sense must take part in determining content and services. This is a
classification that Internet is not something apart from universal culture,
but increasingly a basic component of it.

Sensitivity to National and Local Cultures

It belongs to all there is no barrier of national and local cultures. It
cannot be subject to one set of values like local TV channel, local
newspaper, we have to accommodate multiplicity of usage. Children
should follow some rules while they are on Internet, there are some do’s
and do not’s on Internet.

While Doing School Work

Internet must be used to gain knowledge and to do school work. We
must not copy the information without consent of original owner and
sometimes the copyright issues may arise and will be punished.

While using e-mail and Chatting over Internet

Internet must be used for communication with family, friends and
known members. Children should not use Internet chatting or
communicating with strangers and also forwarding the e-mails from

Legal and ethical aspects of
information technology

Chapter - 5
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strangers. Sitting long hours on Internet continuously might be costly affair to your family
as Internet resources and the Internet bandwidth are available on chargeable basis.

Pretending to be someone else

Children must not use Internet to pretend as someone
else & fool others by hiding your identity. Similarly do not want others
to pretend as someone else by hiding their true identity & communicate.

Using Bad Language

Children must not use rude or bad language while using email, chatting,
blogging and social networking. We need to respect others views and should
not criticize anyone on Internet.

Hide Personal Information

Children should hide their personal information from
strangers like home address, telephone numbers, hobbies and should not
give personal photographs etc. these might be the resources for strangers
to misuse and can be shared to others without your concern.

While Downloading

Internet is used to learn about the music, video and games by
listening to it, and learning how to play games. We must not use it
for downloading them or share the copyrighted material. The same
should be taught to children and they must be aware about the

importance of copyrights and issues of copyright.

Tips for Internet Usage

Do’s :

 Do the Internet improve your knowledge and to do a school work ?

 Do the Internet useful for communication with family and friends ?

 Do the Internet useful for listening the music, video, learning how to play
instruments etc.

 Do the Internet useful gain the knowledge ?
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Don’t :

 Don’t use the Internet to copy the information and say it is your own

 Don’t use the Internet to communicate with strangers

 Don’t use the Internet to make strangers as your friends

 Don’t  pretend someone else and try to fool others

 Don’t waste the resources like people, capacity and computers

 Don’t destroy the integrity of computer-based information

 Don’t disrupt the intended use of internet

 Don’t give personal information like address, names, passwords etc.

Summary

In this chapter you have learnt about the ethics of Internet.

1. Teacher should plan a role play on do’s and don’ts.

2. Ensuring participation of all the students in roleplay.

3. Observe & record the students use of Internet.

4. Organise competition like essay writing, elocution, puzzle game etc.,

1. Should participate in roleplay, essay writing, and the elocution competitions.

2. Observation & recording of  websites mentioned in news papers & T.V.

G Free Zone G Internet ethics

G Copy right G Identity

*****

Teacher Activity

Student Activity

Key Words



28 SCERT, T.S., Hyderabad

Learning Objectives

In this chapter you will be able to understand about ;

G   Organise data using folders

G   Find files and folders

G   Create shortcuts

Concept of Files and Folders

You would have already
learnt about the concepts of files and
folders. Here is a small recap.
Information in a computer is stored
in the form of files. These files can
be arranged in an organised manner
with the help of folders.

A folder can contain files and
other related folders. Folders created within a folder are called subfolders.

For example, you can create a folder by your name and have subfolders for different
subjects. Within each subject folder, you can have files of that particular subject.

Finding Files and Folders

There are times when you require certain files that you had created long time back.
You may not even remember where you saved those files in the hard disk. For such situations,
you can use the Search option provided by Windows XP.

The Search option in Windows XP helps you to locate files and folders in your
computer.

To open the Search pane,

1. Click the search icon  on the toolbar..

Organizing Files and FoldersChapter - 6
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The Search Companion pane is displayed

2. Click the All files and folders option

3. Specify the name of the file or folder you want to search

4. Select the computer or drive or folder where the search has to happen.

5. Click the Search button.

The results are displayed in the right pane



30 SCERT, T.S., Hyderabad

Creating Shortcuts

Shortcuts are the easy and quick way to open applications without using the Start
menu. You can create shortcuts for any number of programs and place them on the desktop
or the quick launch bar for easy use. A shortcut is actually a link to the physical location
where the application resides.

Shortcuts for Applications

You can create shortcuts for frequently used applications and place them on the
desktop.

Whenever you want to open the application, you can simply double-click the shortcut
instead of opening it using the Start menu. The shortcut for the application will always be
available on the desktop.

To create shortcut for applications,

1. Click the Start button on the taskbar.

2. Choose the All Programs option.

3. Select and right-click the application for which you want a shortcut.

4. Click the Create Shortcut option.
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The shortcut for the application will be placed on the All Programs menu list. Drag
the shortcut to the desktop. The arrow in the icon indicates that it is a shortcut.

Shortcuts for Documents or Files

As you can create shortcuts for applications, you can also create shortcuts for
documents and other files. In Windows XP, you can create shortcuts for a file, program,
folder, printer or a computer.

To create shortcut for documents or files,

1. Open My Computer.

2. Double-click the drive where the file is placed.

3. Select and right-click the file for which you want a shortcut.

4. Choose the Send to option.

A submenu is displayed.

5. Click the Desktop (create shortcut) option.

Startup Programs

Startup programs are programs that open automatically each time you start Windows.
To make a program start automatically on your system, it should be added to the Startup
folder.

The Startup folder displays a menu list of information about the programs added to it.

For example, to check your mails as soon as you start your computer, you can create
a shortcut for Microsoft Outlook in the Startup folder.

To add a program to the Startup menu;

1. Create a shortcut for the program.

2. Drag the shortcut to the Startup option on the All Programs submenu.
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Summary

The information in the computer is stored in the form of files. Files can be arranged
in an organised manner by using folders.

The Search option in used to find files and folders.

Shortcuts are the easy and quick way to open applications without using the Start menu.

1. Show casing the creation of folders & files.

2. Use of folders & Files.

3. Creating of Short Cuts.

1. Creating folders & files.

2. Use of folders & files.

1. _______________is used to arrange files in an organised manner.

2. The _______________ option is used to search a file or folder.

3. _______________ contains the link to the physical location where the application
resides.

4. The ____________option in Windows XP helps you to locate files and folders in
your computer.

G   Pane G   Folder G   Sub-Folder

G   Shortcut G   Submenu G   Right-Click

*****

Teacher Activity

Key Words

Student Activity

Test Your Knowledge
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Learning objectives

In this chapter you will be able to understand about ;

G   Rename files and folders

G   Copy and move files and folders

G   Select multiple files and folders

G   Delete files and folders

G   Empty the Recycle Bin

G   Restore a file from the Recycle Bin

Introduction

Windows allows you to change file names. Windows also allows you to copy, move
and delete files and folders. Such actions performed on files are called file operations.
These actions can be performed on folders also. All these operations can be performed by
using either My Computer or Windows Explorer.

Renaming Files and Folders

Changing the names of files or folders
is called renaming. In the previous class, you
had created a text file having your friends’ names
and addresses. The name of the file is “New
Text Document”. Suppose you want the file
name to be changed to “Addresses”.

To rename a file

1. Select the “New Text Document” file.

2. Click the File menu.

3. Click the Rename option

Working with FoldersChapter - 7



34 SCERT, T.S., Hyderabad

The file name “New Text Document” is highlighted

4. Type the name “Addresses”.

5. Press the Enter key.

The file name changes to “Addresses”.

Alternatively,

1. Right-click the file.

A pop-up menu appears.

1. Click the Rename option as shown

Suppose you now want to change the name of your
folder to “MyFolder”. Renaming a folder is similar to
renaming a file.

You can use any of the above methods to rename the folder.

Copying a File or Folder

You now know how to create a folder and then, create a file in
it. Suppose you want to make a copy of the text file “Addresses”
on the desktop.

You can copy files and folder using My Computer or Windows
Explorer. To copy the file by using Windows Explorer:

1. Open the Windows Explorer window.

2. Select the file “Addresses”.

3. Click the Edit menu.

4. Click the Copy option.

5. Select the Desktop icon in the left pane of the window.

6. Click the Edit menu.

7. Click the Paste option.

Your file has now been copied to the desktop.
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Moving Files and Folders

Your folder is currently in the C: drive. Suppose you want it to be moved to the My
Documents folder.

To move files or folders by using Windows Explorer:

1. Select the “My Folder” folder.

2. Click the Edit Menu.

3. Click the Cut option.

4. Select the My Documents folder.

5. Click the Edit menu.

6. Click the Paste option.

Now, the My Folder has been
moved to the My Documents folder

Selecting Multiple Folders and Files

Consider the following situation.

You have created a new folder called “My Pictures” under the My Documents folder.
You also created a number of drawings in Paint and saved the pictures under this folder.

You want to make a copy of all these pictures on the desktop. But it is very time-
consuming to copy the files one by one. Windows helps you by allowing you to copy or
move multiple files at the same time. For this, you must know how to select multiple files.

To select all files and folders within a folder:

1. Open the folder. The contents of the folder appear in the right
    pane.

2. Click the Edit menu.

3. Click the Select All option

All the files within the “My Pictures” folder are selected as shown
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Now, you have to use the
Copy and Paste options only
once to copy the pictures to the
desktop.

Consider a situation where
you do not want to select all the
files but want to select the last
three files. The Shift key can be
used to select consecutive files
and folders.

To select consecutive files by using the Shift key

1. Click the first item to be selected, in this
case, the file “My House”.

2. Press and hold the Shift key.

3. Click the last item to be selected, in this
case, the file “Town”.

All the files between the first and the
last item you clicked are selected. The
selected files and folder are shown as Windows also provides an option to select all the
files and folder within a particular folder.

You just saw how to select consecutive files from a folder. Windows also allows you
to select non-consecutive files in a folder. This is possible by using the Ctrl key.

To select multiple files by using the Ctrl key

1. Click the first item to be selected.

2. Press and hold the Ctrl key.

3. Click each of the items to be selected.

The selected files and folder are shown in
this picture.
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Deleting Files and Folders

Windows allows you to delete
files and folders on your computer.
Deleting files that you no longer need
frees disk space and also keeps your
data well organised.

For example, if you want to delete the file “Addresses” from the folder “My Folder”:

1. Select the file you want to delete.

2. Click the File menu.

3. Click the Delete option.

A dialog box appears where it asks for confirmation before deleting the file.

The Recycle Bin :

The Recycle Bin holds all the deleted items. When a file or folder is
deleted, it is deleted from the folder or drives and stored in the Recycle Bin.

1.  Double-click the Recycle Bin icon

2.  The Recycle Bin window is displayed

To restore a file or folder back to its original location,

1. Select the file or folder.

2. Click the File menu.

3. Click the Restore option.

Alternatively, right-click
the file or folder and click the
Restore option on the shortcut
menu.

To restore all the items,
Click the Restore all items option
from the left pane.
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To delete a file or folder permanently from the Recycle Bin, perform the following steps,

1. Select the file or folder.

2. Click the File menu.

3. Click the Delete option.

Alternatively, select the file and press
the Delete key.

A warning dialog box is displayed asking for confirmation before deleting a file or
folder.

If you really want to delete the file or folder, click Yes. Otherwise, click No.

To empty the Recycle Bin,

1. Click the Empty the Recycle Bin option on
the left pane.

A warning dialog box is displayed asking
for the confirmation.

If you want to empty the Recycle Bin, click yes. Otherwise, click No.

Sharing a Folder

A folder is a means of organising programs and documents on a disk and can hold
both files and additional folders within it. Folders can contain different types of files such
as documents, music, pictures and programs. Windows XP allows you to share a folder on
the network. Sharing allows other users to access the folder on your computer through the
network.

To share a folder,

1. Click the Start button.

2. Click the My Computer option.

3. Double-click the drive where the folder
is placed.

4. Select and right-click the folder that has
to be shared.
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5. Click the Sharing and Security option on the shortcut menu.

The Properties dialog box of the folder is displayed.

6. Select the Share this folder on network checkbox.

If you do not want the network users to make any changes to this folder, clear the
Allow network users to change my file checkbox.

7. Click the Apply button, and then click the OK button.

You can also change the shared name of the folder. To change the name of the folder
on the network, enter a new name in the Share Name text box. This will not change the
name of the folder on your computer, but will only the name as others will see.

Summary

You can rename, copy, move or delete a folder using Windows Explorer.

Demonstrate the creation, rename, copy, move, etc., of folders & files.

I Student should create & use all options as hands on practice under the guidance of
teacher.

II   Lab Work
Folder

My School          My Favourites

1. Create a folder in the C:.

2. Rename the folder as “My Folder”.

3. Create two folders under “My Folder” namely, “My School” and “My Favourites”.

4. Create two Text documents under the folder “My School” and rename it as “Marklist”
and “Friendslist” respectively.

5. Create a Paint file under the “My Favourites” folder and rename it as “Favourite
Pictures”.

Teacher Activity

Student Activity
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6. Move the Favourite Picture” file from the “My Favourite” folder to the “My School”
folder.

7. Copy the “Friendlist” file from the “My Favourite” folder to the “My School” folder.

8. Make a copy of the “Friendlist” file in the “My Favourites” folder.

9. Delete the “Friendslist” document in the “My School” folder.

10. Open the Recycle Bin and restore and deleted file.

11. Permanently delete the copy of the “Friendlist” file in the “My Favourites” folder.

12. Share the folder “My Folder”.

I Fill in the Blanks

1. You can change the name of your folder using the ____________ option.

2. The _________ option is used to copy a file from one place to another.

3. To select the files successively the _________key is used.

4. When a file is deleted from a folder, they are moved to the ______________.

5. The ___________ option is used to delete all the files and folders in the Recycle
Bin.

6. Data, information and other resources can be shared across machines by sharing the
______________.

II True or False

1. You cannot delete a folder, if it is going to hold few files. ( )

2. You can change the name of a folder or file. ( )

3. The Ctrl key is used to select the files and folders that are consecutive.( )

4. The Select All option is used to select all the files and folders. ( )

G   Mutliple Files G   Recycle Bin G   Sharing

*****

Key Words

Test Your Knowledge



ICT Teacher Hand Book 41

Learning Objectives

In this chapter you will be able to understand about ;

G   Open an existing presentation

G   Add new slides

G   Insert pictures

 Opening an Existing Presentation

 You now have to open your file to continue with preparing the presentation. The
saved file has to be opened again. The steps to open an existing presentation are:

1. Click the Office Button.

2. Click the Open option.

The Open dialog box appears as shown

3. Select the file to be opened. The file name you select will appear in the File name
box. In this case, the filename is “Animals”.

4. Click the Open button.

Working with Slides in Microsoft
Power Point

Chapter - 8
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Adding New Slides

Now you have to add the second slide. To add a new slide:

Now you have to add the second slide.

To add a new slide

1. Click the Home tab.

2. Click the New Slide option from the slide group.

The Office Theme pane is displayed as
shown in Figure. This task pane contains a
list of slide layouts. You can select a slide
with the layout you require.

For example, the first slide that you used
is called the Title Slide. It is used to type
titles for presentations.

The new slide you are going to add must
contain the list of domestic animals. For
this, you can use the Title and Content
slide layout. This slide will contain one
heading and will allow you to type some
text in the form of points.

To add the Title and Content slide, select
that slide from the Office Theme pane as
shown
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Now, you can type the heading ‘Domestic Animals’ in the placeholder for the title.
Then, you can type the list of domestic animals in the next placeholder of the slide. The
names of the domestic animals are displayed in the form of a bulleted list.

After typing, your new slide will look like

Inserting Pictures

Suppose you want to add a new slide about “The Cow” and insert a picture of the cow
in the slide. You can type the text in the text placeholder and add the picture in the clip art
placeholder

Domestic Animals
   Cow

   Buffalo

   Sheep

  Goat

   Dog

   Cat
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To add a picture to this slide

1. Double-click the clip art button.

The Clip Art task pane appears. It shows you a list of clip arts present in your computer.
It also has a Search text box where you can type a word as a hint. Using this hint, Power
Point will select clip arts from your system whose name matches with that of the search
text and displays them in the list box below.
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You now want the picture of a cow.

2. So, type the text “cow” in the Search for text box.

3. Click the go button.

4. List of pictures related to the search are displayed.

5. Select the required picture.

6. The Picture is inserted to the slide.

Now, the picture of the cow gets inserted in the clip art placeholder as shown.

You can create the other slides in your presentation, which deal with wild animals as
shown

Summary

To open an existing presentation;  Click the Open option on the Office button.

You can insert clip arts into your slides.

Demonstration of slide Presentation.

I 1. Make  a slide Presentation related to your text book (one slide).

2. Learn to use all options available.

Wild Animals
   Tiger

   Lion

   Fox

   Bear

   Wolf

   Cheetah

The Tiger
   The tiger is a ferocious animal.

   It is a carnivore.

   It is India’s
     National animal.

 

Teacher Activity

Student Activity
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II Lab Work

1.  Create a new presentation “Air Pollution” with the following slides.

2. Start Power Point and create a presentation with the following slides:

AIR POLLUTION

By <Name>

What is Air Pollution
 Presence of harmful gases in the

air.

 Presence of higher level of carbon
dioxide in the atmosphere.

 Presence of solid particles in the
atmosphere.

Causes of Air Pollution
 Industrial Smoke and Dust.

 Vehicles

 Volcanoes

 Forest Fires

The Sun
 Respiratory problems like bronchitis.

 Allergies

 Fatigue

The Solar System

The Sun
 One among millions of stars in the

sky.

 Provides us with heat and light.

 All planets including the Earth
revolve around the sun.

The Planets The Earth
 The Earth is the third planet from

the sun.

 It is the planet which
supports life.

 Three-fourth of the
Earth is covered with
water.

 Mercury

 Venus

 Earth

 Mars

 Jupiter

 Saturn

 Uranus

 Neptune

 Pluto
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3. Insert a picture of the Earth in the last slide.

4. Save the file.

5. Exit PowerPoint

Fill in the blanks

1. The ________ option on the Office button is used to open an existing presentation.

2. The _______ option is used for inserting a new slide.

3. To insert clip arts in the clip art placeholder, you must ____________ it.

G   Insert

G   Drag

G   Clip Art

G   Presentation

*****

Key Words

Test Your Knowledge
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Learning Objectives

In this chapter you will be able to understand about ;

G Appreciate the need for Excel

G Start Excel

G Create a new workbook

G Identify the parts of an Excel window

G Display, move and hide toolbars

G Use keyboard and right-click shortcuts

G Enter and edit labels and values

G Select a range of cells

G Save a workbook

G Close a workbook

G Exit Excel

Microsoft Excel

Excel is a software package, which can be used to store, organise, calculate and
analyse data. It can do all kinds of mathematical calculations. The tasks that you can perform
with it range from preparing a simple invoice to creating elaborate 3-D charts to managing
an accounting ledger for a company. The primary document that you use in Excel to enter,
store and work with data is called a worksheet.

Worksheet

A worksheet is divided into rows and columns that intersect to form cells. A
worksheet is also called a spreadsheet or a sheet, in short. All worksheets, whether they are
on paper or in a computer program, have certain components in common. Figure 1 shows a
worksheet that has the names of students along with their marks in various subjects.

Introduction to Microsoft ExcelChapter -9
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The commonly used terms used in Excel are explained below.

G Cell – The intersection of a row and column.

G Row – A horizontal group of cells in a worksheet. There are 65536 rows in an
Excel worksheet. The row number identifies each row.

G Column – A vertical group of cells in a worksheet. There are 256 columns in an
Excel worksheet. The letters ranging from A to IV are used to identify each column.

G Label – Identifies information on the spreadsheet. For example, in Figure1, the
labels in column A identify the student names and the labels in row 1 identify the
subjects. The headings of rows and columns and any other text entry are called
labels.

G Value – Refers to the data in the worksheet. For example, in Figure 1, the marks of
the students are the values.

G Cell Address – Identifies a cell. Every cell has an address. The column letter
followed by its row number forms the cell address.

For example, in Figure 1, A1 is the cell address of the cell that has the heading
“Student”. Here A represents the column letter and 1 represents the row number. A few
other examples of cell addresses are B1, C2, D12, etc.

G Cell Range – A cell range is a group of continuous cells. For example, A1:A4 is a
cell range. Excel uses a „:  to denote a range of cells. Operations can be performed
on a range of cells.

Figure 1



50 SCERT, T.S., Hyderabad

Workbook

Any worksheet you create is stored in a workbook. A workbook refers to the file
created in Excel. Just as your notebook contains several pages, similarly an Excel workbook
can contain several worksheets.

When you start Excel, a workbook is automatically created and displayed. By default,
this workbook is called “Book1” and contains three worksheets named as Sheet1, Sheet2
and Sheet3. You can change the name of the sheets. You can insert more sheets, if you want
to. There can be a maximum of 256 worksheets in a workbook.

Advantages of using an Electronic Spreadsheet

An electronic spreadsheet is similar to a paper spreadsheet. However, there are
distinct advantages of using an electronic spreadsheet as compared to a paper worksheet.
The advantages are as follows.

G Fast Calculation: Complex mathematical calculations, that have to be done on a
huge volume of data, can be done very easily and quickly.

G Automatic Recalculation: This is a very useful feature of an electronic
spreadsheet. You can specify a formula for performing calculations. Whenever a
value referred to in the formula is changed, the result changes automatically. You
do not have to perform the calculation again.

G Creation of Graphs: The data stored in a spreadsheet can be represented in the
form of graphs. Graphs help you to understand and analyse the data better.

G Auto Recovery: This feature protects your data. A major portion of the data can
be recovered when there is an unexpected power-cut or your computer fails for
some reason. This feature ensures that you do not lose much data in such
circumstances.

G Storage: Data entered in worksheets can be stored for future usage.

G Linking: Excel allows you to work with more than one worksheet at a time and
these worksheets can be linked with each other.
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Starting Excel

Consider the following situation.

Your teacher has to prepare the marks statement of the students. Let us see how this
can be done in Excel. The first step would be to start Excel.

To start Excel

1. Click the Start button.

2. Choose the Programs option.

3. Click Microsoft Office.

4. Click the Microsoft Excel 2007 option

A new workbook is displayed on the screen.

Creating Workbooks

If the Excel window is already open, then you can create a new workbook in the
following manner.

1. Click the Office Button.

2. Click the New option.

The New Workbook task pane appears on the right side of the screen

3. Click the Blank Workbook option.

4. Click Create Button.

A new workbook appears on the screen.
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Interface Elements of an Excel Window

When you start Excel, it opens an Excel window with a blank worksheet as shown above.

Office Button

The Office button, when clicked, displays a drop-down list with a number of options,
such as New, Open, Save, Save As and Print. The options in the Office button list are very
similar to those in the File menu in the previous versions of Excel.

Ribbon It is a strip of buttons and icons located above the work area in Microsoft
Excel 2007. The buttons are grouped under various tabs. Refer the figure given below for
the terms used to access options in Excel 2007.
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Name Box

It displays the name of the active cell or the cell reference.

Formula Bar

It displays the contents of the active cell and is located above the worksheet. It can
also be used for entering or editing data, labels and formulae.

Column Letters

Columns in a worksheet are displayed vertically. Each column is identified by a
letter called column letter in the column header.

Row Numbers

Rows in a worksheet are displayed horizontally. Each row is identified by a number
called row number in the row header.

Active Cell

Data is entered into the active cell with a black outline. A cell is identified by the
alphabet of the column and the numerical tab of the row.

Sheet Tab

It is present at the bottom of the worksheet. It indicates the name of the worksheet.

Using Keyboard and Right-click Shortcuts

You have earlier learnt about the various keyboard shortcuts for frequently used
commands in Office. These shortcuts can be used in Excel also. Table 1 lists the keyboard
shortcuts you have learnt before.
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Key Combination Use

Ctrl + N To Create a new workbook

Ctrl + O To open an existing workbook

Ctrl + S To save the current workbook

Ctrl + X To cut the contents of the selected cell (s)

Ctrl + C To copy the contents of the selected cell (s)

Ctrl + V To paste the contents that were previously cut or copied

Ctrl + Z To undo the action previously done

Ctrl + Y To redo the action previously undone

Ctrl + A To select the contents of the entire worksheet

Table - 1

You can quickly access some of the above-mentioned
commands through a right-click also. When you right-click
on a cell, the following pop-up menu appears you can select
the required command from the pop-up menu.

Entering Labels and Values

Once you create a workbook, you can start entering data.
To organise the data in your worksheet, you can add headings
(that is, labels) to rows or columns before you enter the actual
data. The data entered in a cell can be a label, value or formula.

Now, you have to start preparing the marks statement. First, you have to type the
labels - “Student”, “English”, “Maths” and “Science” for the columns.

To enter the first label “Student Name”:

1. Click the cell A1 where you want to enter the data.

The cell now becomes the active cell.

2. Type the word “Student Name”.

3. Press the Enter key.
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In the same way, enter the other labels. Now, proceed to type the student names in
the cells below the label “Student Name”. Type the marks of each student under the respective
subjects. Enter the names and marks of at least 10 students.

The worksheet appears as shown below.

Editing Labels and Values

If you enter a wrong value or want to make any change to the entry already made,
Excel allows you to make the corrections.

To make corrections:

1. Double-click the cell.

2. Use the Backspace key or the Delete key to make corrections.

3. Press the Enter key.

Alternatively,

1. Click the cell.

2. Click the Formula bar.

3. Use the Backspace key or the Delete key to make corrections.

4. Press the Enter key.

Selecting a Range

For copying or moving a range of cells, you first need to select the range of cells.

 Table 2
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To select a range of cells

1. Place the cell pointer at the position from where the selection has to start.

2. Hold the Shift key down and press the Right arrow key if you want to select the cells to
the right or press the Down arrow key if you want to select the cells below the starting
cell.

3. Press the arrow key as many times as the number of cells to be selected. Stop when you
reach the last cell in the range.

Alternatively,

1. Click the cell from where the selection has to start.

2. Then hold the Shift key down and click the last cell till which you want to select.

Or

Click and drag the mouse till the entire range of cells has been selected.  To select
an entire column, click the column heading.

To select an entire row, click the row
heading.

To select the entire worksheet:

1. Click Select All button

Saving Workbooks

You can save your workbook so that it can be used later.

To save a workbook:

1. Select the Office button.

2. Click the Save option.

The Save As dialog box appears as shown
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3. Type the name Marks in the File name box.

4. Click the Save button.

Your file has now been saved with the name “Marks.xlsx”. All Excel files are saved
with the extension .xlsx

Closing Workbooks

Once you finish working on the workbook, you can close it.

To close a workbook

1. Click the Office Button.

2. Click the Close option.

The workbook is closed.

Exiting Excel

To exit Excel

1. Click the Office Button.

2. Choose the Exit Excel option.

The Excel window is closed.

Summary

Excel is a software package, which can be used to store, organise, calculate and
analyse data.

G A worksheet is a combination of rows and columns.

G The intersection of a row and column is called a cell.
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G A cell address is formed with the column letter and the row number.

G The active cell is the cell you are currently working with.

G You can enter data in the active cell only.

G You can select a range of cells to work on them as a whole.

G To save a workbook, click the Save option on the Office Button.

G To close a workbook, click the Close option on the Office Button.

G To exit Excel, click the Exit Excel option on the Office Button.

Demonstration of Excel worksheet.

Hands on practice - making a work sheet for demo.

Fill in the blanks

1. An Excel file is called a ___________.

2. An Excel worksheet has __________ and _________.

3. A new Excel workbook has __________ sheets by default.

4. The cell that has a highlighted rectangular box positioned on it is called the
     _________.

5. To save a workbook, click the ________ option on the _______ Button.

G   Cell G   Active Cell G   Row G   Column

G   Range G   Formula Bar G   Linking

*****
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Student Activity

Test Your Knowledge
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Learning Objectives

In this chapter you will be able to understand about ;

G Know what is WWW?

G Explain the advantages of using WWW

G Define URL

G Define the term Web browser

G Use the Internet Explorer to browse

G Recall the terms used in Internet

World Wide Web

WWW stands for the World Wide Web. It is a series of interconnected servers that
contains information in form of text, pictures, sounds and animation. You would have seen
a library. It consists of millions and millions of books with pages of text, pictures, sounds
and animation. WWW is very similar to a library. Just like a library, WWW has information
on different topics. These information pages are stored on different computers that are
connected to the Internet and have links between them. When you click on a certain word,
which is a link in the page, it will take you to another page. Such texts, which act as a link
between Web pages, are called hypertext. These links are called hyperlinks and the pages
are known as Web pages. A collection of related Web pages is known as a Web site, which
is similar to a book containing related information. The first Web page that gets displayed
when the user opens any Web site is called the Home page.

Advantages of Using WWW

The advantages of WWW are:

G A user can click any hyperlink present on the Web page and jump to a related Web page
on the same or a different Web site.

G A Web page can contain text, pictures, audio, and video clips which makes it interesting
to the user.

InternetChapter - 10
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G A user can interact with a Web page by filling a form, by running a program or select
options from a Web page.

URL

You know that each house has an address. The address has a door number, street
name, city name and pin code. The address is used to locate a house easily. Similarly each
web site has an address. This address is called the URL (Uniform Resource Locator) to a
Web site.

Examples for Web site address are:

G www.yahoo.com G    www.hotmail.com G    www.google.com

Web Browsers

We are already aware of the process of connecting to the Internet. But, more than
connecting to the Internet, you should be able to use the services provided by the Internet.
For example, you may use WordPad to type a letter and Paint to draw a picture. Likewise,
Web Browser is a software program using which you can open any Web site to browse and
avail the services offered by the Web site. Web browsers are capable of displaying Web
pages containing text, pictures, sound and video files.

The commonly used Web browsers are:

G Internet Explorer G   Netscape Navigator

G Hot Java G   Opera

Using the Internet Explorer

The Microsoft Internet Explorer is a Web browser developed by Microsoft. The
Internet Explorer comes free when you buy Windows 98 or Windows 2000 or Windows XP
operating system.

To launch Internet Explorer

Double-click the Internet Explorer icon (    ) present on the desktop.

Alternatively,

1. Click the Start button.

2. Click the Internet Explorer option from the menu.
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The Internet Explorer window opens up as shown

The Internet Explorer window has title bar, menu bar, toolbar, address bar and status
bar. To visit a web site, you have to type the Web site address in the address bar and press the
Enter key. The home page of the corresponding Web site will be displayed

Click the Forward button on the toolbar to move to the next page and the Back
button to go to the previous Web page visited.

Terms Used in the Internet

Let us recall the Internet terms, which you have already learnt.

G Web browser is a software that allows the user to display and interact with a Web site.

G Web page is a page which may contain text, pictures, audio, and video clips.

G Web site is a collection of related Web pages.

G Home page is the first Web page displayed when the user opens any Web site.

G Hypertext Transfer Protocol (HTTP) is a protocol used on the WWW to transfer Web
pages. A protocol is a set of rules that the computers follow to communicate with each
other.
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G HTML (Hypertext Markup language) is a language used to create Web pages.

G Uniform Resource Locator (URL) is a Web addressing system that is used to identify
each Web site uniquely on a network.

Example of an URL: http://www.aub.edu/services/faq.html

Summary

G WWW stands for the World Wide Web. It consists of millions and millions of Web
pages.

G Collection of related Web pages is known as Web site that is stored on different
computers that are connected to the Internet.

G Hyperlinks are used to link the related Web page.

G Web page is a page which may contain text, pictures, audio, and video clips

G Home page is the first Web page displayed when the user opens any Web site.

G A protocol is a set of rules that the computers follow to communicate with each other.

G Hypertext Transfer Protocol (HTTP) is a protocol used on the WWW to transfer Web
pages.

G HTML (Hypertext Markup language) is a language used to create Web pages.

G Uniform Resource Locator (URL) is a Web addressing system that is used to identify
each Web site uniquely on a network.

G Internet Explorer is a Web browser developed by Microsoft.

G A Web browser is a program that enables you to view the Web site available on the
WWW.

G You can open the Internet Explorer using the Internet Explorer icon on the desktop.

G The Internet Explorer window has the Address bar where you type the Web site address.
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Show case a browser and its use.

I 1. Browse any website using URL.

2. Find its URL while clicking on menu.

3. Use search option.

II Lab Work

1. Visit http:/ http://www.nineplanets.org/ to collect information about the solar system.

2. Visit http://www.nationalgeographic.com/kids/creature_feature/archive/ to view
photographs of animals and collect information about them.

3. Visit http://www.petsmart.com to gather information on your favourite pet..

4. Visit http://www.mapsofindia.com/maps/andhrapradesh/andhra-pradesh-district.htm to
view the map of Andhra Pradesh.

5. Visit www.indiatravelinfo.com/wildlife.htm to learn about wildlife sanctuaries in India.

6. Browse the site http://www.historyofindia.com to get information about Indian history.

7. Visit http://www.jiskha.com/social_studies/world_issues/ozone_depletion.html and
learn about ozone depletion.

Fill in the blanks

1. _____________ is software that allows the user to display and interact with a Web
site.

2. ______________ is a collection of related Web pages.

3. HTTP stands for _______________.

4. HTML stands for _______________.

5. The address of a Web site is also called _______________.

6. WWW stands for _____________________.

Teacher Activity

Student Activity

Test Your Knowledge
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7. __________ are the pages on the Internet that contain text, pictures, sounds and
animation.

8. ____________ is a set of rules that the computers follow to exchange information.

9. You have to type the Web site address in __________ bar.

10. The first page that appears after opening a Web site is known as ____________.

G WWW

G   HTML

G   HTTP

G Browser

G   Home page

G   Web page

*****

Key Words
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Projects
1. Prepare a Power Point presentation with four slides on agriculture in our time.

2. Prepare your class time table by using Microsoft Word and Excel.

3.  Prepare a flow chart of any recipe you know.
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